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Notices

Copyright and Trademarks  

Copyright © Z Corporation 1995-2008. All rights reserved. The information in this document may not be 
duplicated or transmitted in any way without the express written consent of Z Corporation. The information 
contained herein is for the use of Z Corporation customers, who are permitted to create brief excerpts for 
the purposes of training and review. This information may not be incorporated in any commercial pro-
grams, books, databases, or in any kind of software without the consent of Z Corporation.

Z, Z Corporation, zp, zb, ZMap, ZPhoto, Z-Cure, Z Prints, ZPrinter, ZCast, ZScanner, ZScan and the Z 
Corp. logo and design are pending/registered trademarks of Z Corporation.

ZPrint® 7.8 System Software Copyright (c) 1996-2008 Z Corporation.This software is based in part on the 
work of the Independent JPEG Group. 

PNG library libpng version 1.2.2 Copyright (c) 1998-2002 Glenn Randers-Pehrson, (Version 0.96 Copy-
right (c) 1996, 1997 Andreas Dilger), (Version 0.88 Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, 
Inc.)

ZLIB general purpose compression library version 1.1.4, Copyright (C) 1995-2002 Jean-loup Gailly and 
Mark Adler.

Microsoft Windows is a trademark of Microsoft Corporation. 

Z Corporation acknowledges the trademarks of other organizations for their respective products or ser-
vices mentioned in this documentation.

Proprietary Information  

Information contained in this document is the confidential property of Z Corporation. Recipient shall not dis-
close such Information to any third party, and shall not use it for any purpose whatsoever other than what is 
required to install and use the ZPrinter® 650. 

Use of Equipment  
Z Corporation's Equipment, and use of the Equipment, may be subject to limitations imposed under 
patents licensed to or owned by Z Corp., and is to be used solely for the fabrication of appearance models 
and prototypes using new Z Corporation-supplied consumable from Z Corporation or its authorized 
distributors in the original packaging. Other uses may be restricted; contact Z Corporation for further 
information. Consult the User's Manual before operation of any Z Corporation Equipment. The Equipment 
may be covered by the following U.S. Patents and/or U.S. Patent Applications:

5,204,055 5,340,656 5,387,380 6,007,318 6,375,874 5,902,441
6,416,850 6,610,429 6,403,002 5,660,621 5,851,465 6,397,922
6,036,777 6,989,115 7,037,382 7,291,002 7,387,359 7,087,109
7,332,537 11/335,282 11/860,087 60/558,940 12/118,899 11/000,100
11/606,960 60/808,721 11/807,325 11/807,329 11/807,175 11/807,237
09/706,350 09/835,292 11/453,695 60/472,221 60/499,220 11/732,490
60/879,703 11/952,727 12/035,743.

The Equipment is designed to be used by design engineers and other professionals in the production of 
early-stage 3D appearance models and prototypes. The Equipment is not to be used to produce, either 
directly or indirectly, medical or other products that may require precise dimensions or tolerances to ensure 
the safe and effective operation of such products. You agree to indemnify, defend and hold Z Corporation 
and its officers, directors and employees harmless from and against any and all claims, losses, damages, 
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costs and expenses resulting from any use of the Equipment other than for the production of early-stage 
appearance models and prototypes.

Warranty   
Your ZPrinter® is guaranteed to be free of defects in materials and workmanship, when used for produc-
tion of early-stage appearance models and prototypes and with Z Corporation consumables, for the period 
described below under WARRANTY PERIOD. All consumables and materials are guaranteed to perform 
as described in their specifications when stored and used as directed, up to the expiry date printed on the 
label. THE COMPANY MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND DISCLAIMS ALL WAR-
RANTIES INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE AND ANY OTHER OBLIGATIONS OR LIABILITIES 
WHETHER IN CONTRACT, WARRANTY, NEGLIGENCE OR OTHERWISE. THE COMPANY IS NOT LIA-
BLE FOR ANY DIRECT, INDIRECT, SPECIAL, PUNITIVE, CONSEQUENTIAL OR INCIDENTAL DAM-
AGES INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS OR BUSI-
NESS INTERRUPTION ARISING OUT OF THE USE OR INABILITY TO USE PRODUCTS OR 
SERVICES SOLD HEREUNDER. IN NO EVENT WILL THE COMPANY'S LIABILITY EXCEED THE 
TOTAL CHARGE OF THIS ZPRINTER® 650.

WARRANTY PERIOD: In the U.S., warranty is for 90 days and covers service, parts and training material. 
In the EU, warranty is for 1 year and covers service, parts and training material.

Symbols  

The following symbols are used on the ZPrinter 650 and in this manual.

Change History  

Rev. A  10/21/2008  

General Caution: User should use care to avoid 
possible damage to equipment.

Hot Surface: User should use care when working 
near or on the labelled item.

High Voltage: User should use appropriate electri-
cal safety precautions.
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1 ZPrinter 650 Overview
Welcome to the exciting world of 3D Printing with our newest 3D Printer, the ZPrinter 650. The ZPrinter 
650 incorporates many new features that automate and streamline the 3D printing process. The full-color 
capability, an easy-to-use, quiet, office-friendly design, combined with high-performance composite materi-
als, makes ZPrinter 650 the fastest, most cost-effective 3D printer available today for rapid prototyping. 

This manual will instruct you on how to take care of your printer and give you an introduction to 3D Printing. 
In addition, you can find information about 3D printing and its many applications and techniques on our 
3DP User Web site at zcentral.zcorp.com.

This Web site is tailored to both beginner and advanced customers. We recommend that you register 
immediately to receive free, unlimited access to this excellent resource.

1.1  New Features
The ZPrinter 650 is our fastest, most capable printer. We’ve built in the features customers most asked for:

• Larger build volume

• Higher resolution

• Automated Powder Loading/Removal/Recycling

• Quick-Load Binder and Cleaning Solution Cartridges

1.2  Specifications
 

Printer Dimensions and Type • With top cover closed: 79” wide x 30” deep x 57” high 
(201 cm wide x 76 cm deep x 145 cm high)

• With top cover open: 79” wide x 30” deep x 75” high 
(201 cm wide x 76 cm deep x 191 cm high)

• Crated: 87” wide x 48” deep x 64” high (221 cm wide 
x 122 cm deep x 163 cm high

• Floor standing model on six casters. Two front cast-
ers are lockable. 

• Full color capability; color shell thickness =.025” 
(.635 mm)

• Integrated powder removal and vacuum units.

Printer Weight 750 lbs (340 kg)

Network Connectivity TCP/IP 100/10 Base T

Operating Environment

Ambient Temperatures

Ambient Relative Humidity

• Maximum Temp. Range: 50-80° F (10 - 26.6° C)

• Recommended Temp. Range: 55-75° F (12.7 - 
23.9°C)

• Maximum RH Range: 15 - 60%, non-condensing

• Recommended RH Range: 20 - 55%, non-condens-
ing

(May experience sub-optimal performance at extremes.)
zcentral.zcorp.com 1 All Rights Reserved
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1.3  Computer/System Requirements

1.3.1 Recommended System
• Operating System: Microsoft Vista 32-bit or XP Professional 

• Processor: Intel® Core™2 Duo Desktop Processor E8200 2.66Ghz or better

• Video: 512MB Video card (recommend nVidia Quadro FX1700)

• Memory: 4GB or better

• Hard Drive: 1 GB of free space

• Ethernet 10/100 Base T

These system configurations may require a higher performance computer based on file size and type. For 
more information, please contact your local Reseller, or visit the support section of our Web site:
zcentral.zcorp.com. 

1.4  How 3D Printing Works
The 3D Printing System is based on the Massachusetts Institute of Technology's patented 3DP™ Technol-
ogy (3D Printing). The 3D Printing process requires:

Build Volume 10” x 15” x 8” (254 mm x 381 mm x 203 mm)

1200 cubic inches build capacity

Build Speed 2-4 layers per minute

Layer Thickness .0035” - .004” (.089 - .102 mm)

Resolution 600 x 540 dpi print resolution

Noise Levels During Printing = 57dB

Emptying Overflow = 66dB

Vacuuming - Cover Open = 72dB

Fine Powder Removal = 72dB

CSA, CE Approval Meets CE certification standards and UL standards. 

Power Requirements 100V, ~50-60 Hz, 15 Amp.

115V, ~50-60 Hz, 15 Amp.

230V, ~50-60 Hz, 8 Amp.

Note: Due to high amperage, a dedicated outlet is 
strongly recommended.

Materials - 

High Performance Composite Zp131 Powder

Zb61 Binder

Z Corp. is always evaluating new materials for use with 
your printer. For the latest information check the Materials 
section of our Web site:

 zcentral.zcorp.com. 

Print Heads 5 each HP11 (clear, black, cyan, magenta, yellow) 

1520 jets total

Liquid Waste System Pull-out tray 
zcentral.zcorp.com 2 All Rights Reserved
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• A 3D Printer 

• Importing a solid 3D modeling file into the ZPrint Software 

• Setting up your files to print in the ZPrint/ZEdit Software

• Printing, powder removal, and drying the part

• (Optional) Applying post-processing materials to the printed part

To start, the ZPrint Software takes a three-dimensional design file, (ZPrint is compatible with most 3D mod-
eling software files) and converts it into cross-sections, or layers, that are between 0.0035" - 0.004" (0.089 
- 0.102 mm) thick. Before printing, ZPrint evaluates the part geometry and checks if there are enough 
materials in the printer to print the number of layers required to build the part. If there are, the printer then 
prints each layer, one after the other, from the bottom of the part to the top. If not, ZPrint will prompt you to 
add powder, to add binder, or to change a print head before it will start the print job. 

During printing, binder is first applied with a higher saturation to the edges of the part, creating a strong 
“shell” for the part exterior. Next, an infrastructure that works like strong scaffolding is created for the part 
walls, which are also built with a higher saturation of binder for added strength. The remaining interior 
areas are printed with a lower binder saturation, which gives the part its stability.

When the part is finished printing, the printer heats up to the appropriate temperature and dries the part 
while it is still in the Build Bed surrounded by powder. When the drying cycle is finished, an automatic pow-
der removal cycle empties the Build Bed of most of the excess powder around the part, and returns that 
powder to the Feeder for reuse. After the bulk of the powder removed, the part is moved from the Build 
Bed to the integrated Post-Processing Unit where any remaining powder is cleaned off the part. 

After the part is powder-free, it is ready to be removed from the printer. You can evaluate the part as it is, or 
you can choose to post-process the part with infiltration products to give it additional strength, durability, 
and color vibrancy. With the finished part in your hands, you can start improving or modifying your design 
within the same day, and usually within hours.
zcentral.zcorp.com 3 All Rights Reserved
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1.5  3D Printing Process Diagram

1.6  Important Terms
Air Wand - The tool located in the Post-Processing Unit that supplies air pressure. Use this tool to remove 
all remaining powder from a part after the initial (automatic or manual) powder removal.

Alignment Sensor Window - Located on the underside of the Carriage unit. Wipe powder off of the Align-
ment Sensor Window every time you replace a print head, or whenever you remove a print head to clean 
the contacts.

Binder - Solution that is dispensed through the HP11 print head and applied to the powder. The binder sat-
uration value will vary depending on the part geometry. The ZPrint software uses a default core and shell 
saturation value that is suitable for most part geometries. 

Build Bed - The 10” x 15” x 8” area in front of the Feeder where the part is printed. The platform of the 
Build Bed can be raised or lowered using the appropriate command on the printer LCD menu. Before each 
build, the printer fills the Build Bed with powder and then spreads a layer of powder to ensure the surface 
of the Build Bed is completely smooth.

Build Chamber - The left, interior side of the printer that houses the Build Bed, Service Station, Parking 
Caps, the Debris Separator, the Carriage, the Fast Axis assembly, the Vacuum Hose, the Heater Vent, and 
the Feeder. 

Carriage - Assembly that houses the Print Heads, Pogo Pin Connectors, and the Alignment Sensor Win-
dow.

Consumables - Powder-Binder-Infiltrant products that are available in a variety of systems for all of your 
color or monochrome modeling needs. All consumables have been developed for the fastest printing 
speeds and lowest materials costs.

Debris Separator - Located above the Heater Vent in the Build Chamber. Its function is to prevent chunks 
of particles from going back into the printer Feeder during any vacuuming operation. 

Deck - Area surrounding the Build Bed.

Depowder - Process of removing excess powder from a newly printed part. First, there is the initial (auto-
matic or manual) powder removal process, which removes the bulk of the powder after the part is dried in 
the Build Bed. After the initial powder removal, there is the fine-powder removal process - which cleans the 
part of all remaining powder. 

Feeder - Printer component that stores powder. Powder that is vacuumed up after a build, or powder that 
is automatically (or manually) emptied from the Build Bed, is recycled and returned to the Feeder for reuse. 

Fast Axis - Printer component that houses the Carriage and the Fast Axis rails that the Carriage moves 
on. The Fast Axis moves on the Slow Axis rails which are housed beneath the Build Chamber Deck.

Heater Vent - Located directly below the Debris Separator. The Heater Vent supplies heat to the Build 
Chamber during the warm-up cycle, and during the drying cycle.
zcentral.zcorp.com 4 All Rights Reserved
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Infiltration - Process of applying various post-processing products (resins, wax, epoxy, etc.) to fully 
depowdered parts to give them specific properties such as strength, durability, and color vibrancy.

LCD - Liquid Crystal Display.

Parking Caps - Printer component that prevents the print heads from drying out between print jobs. It is 
important to clean the Parking Caps after every build. Beneath the Parking Caps is the Parking Spittoon, 
which catches binder that is periodically ‘spit’ out of the printheads. 

Platform - The bottom, metal plate of the Build Bed. The platform contains numerous small holes that 
allow excess powder to escape through the bottom of the Build Bed during initial (automatic or manual) 
powder removal. The platform can be raised or lowered by selecting the appropriate command on the 
printer LCD menu.

Pogo Pins - Gold contact pins for the print head contacts. Clean the Pogo Pins with an alcohol swab 
whenever a print head is removed, cleaned, or replaced. 

Post-Processing Unit - The right side of the printer that houses the Post-Processing Tray and the Air 
Wand. Printed parts are moved from the Build Bed to the Post-Processing Unit for final removal of any 
powder left on the part, and for infiltration.

Powder - Very fine particles that are not bound together. Powder is spread layer by layer and saturated 
with binder to create a solid object.

Print Head - There are five Print Heads for the ZPrinter 650 - clear, black, cyan, magenta, and yellow. All 
are HP11 print cartridges. When a new HP11 print head is installed, the printer runs an automatic purge 
cycle to clean the print head of its ink and to prepare it for dispensing binder. Note: Only HP11 model 
C4810A Black cartridges can be used in the ZPrinter 650.

Print Head Contacts - The contact points on a print head cartridge that match up with the Pogo Pins. 

Purge - Process of removing ink from the HP11 print head to prepare it for dispensing binder.

Service Station - Cleans the print head jets to remove powder residue during printing. It is extremely 
important to clean the Service Station after every build to remove residue buildup that gets left on the Ser-
vice Station during a build. If the Service Station is not clean, your print heads will not get properly cleaned 
and this will result in premature print head expiration.

Waste Tray - Absorbs the binder waste and will require changing only when you are prompted to in ZPrint. 
Located at the front bottom of the printer. 
zcentral.zcorp.com 5 All Rights Reserved
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1.7  ZPrinter 650 Components
The main components of the ZPrinter 650 system are highlighted below.

1.7.1 System Exterior     

Number Component

1 Printer

2 Post-Processing Unit (PPU)

3 Control Panel

4 Printer Storage Compartment

5 PPU Storage Compartment

6 Arm Holes
zcentral.zcorp.com 6 All Rights Reserved
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1.7.2 Printer Interior  

Number Component

1 Binder Cartridges

2 Debris Separator

3 Heater Vent

4 Vacuum Hose

5 Service Station

6 Deck

7 Fast Axis Assembly

8 Build Bed

9 Front Overflow

10 LCD Display

11 Control Knob
zcentral.zcorp.com 7 All Rights Reserved
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1.7.3 Post-Processing Unit (PPU) Interior     

Number Component

1 Air Wand

2 Air Pressure Control Nut

3 Air Hose

4 Heater Vent

5 Carbon Filter

6 Post-Processing Tray

7 Accessory Tray
zcentral.zcorp.com 8 All Rights Reserved
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1.7.4 Printer Storage

Number Component

1 Tools and Acessories Storage

2 Cleaning Solution Cartridge

3 Print Head Storage

4 Waste Tray
zcentral.zcorp.com 9 All Rights Reserved
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1.7.5 Post-Processing Unit (PPU) Storage

Number Component

1 Tool Basket

2 Parts Trays 
(shown under Dipping Kit)

3 Accessory Tray
zcentral.zcorp.com 10 All Rights Reserved
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1.8  ZPrinter 650 Rear View 

Number Component

1 Power Switch

2 Power Cord

3 Network Cable

4 Electronics Box (E-Box) 
Connections
zcentral.zcorp.com 11 All Rights Reserved

10/21/08

https://zcentral.zcorp.com


ZPrinter® 650 Hardware Manual ZPrinter 650 Overview
1.9  Service Station

Number Component

1 Squeegee

2 Spit Plate

3 Front Overflow
zcentral.zcorp.com 12 All Rights Reserved
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1.10  Parking Caps

Number Component

1 Parking Caps (5 total)

2 Parking Spittoon 
(under Parking Caps)
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1.11  Carriage, Print Heads, and Pogo Pins

1.11.1 Front View

Number Component

1 Print Head (removed)

2 Print Head Contacts

3 Pogo Pins (inside)

4 Septum

5 Print Head (installed)

6 Carriage Cover
zcentral.zcorp.com 14 All Rights Reserved
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1.11.2 Top Inside View

Note: Carriage cover shown removed.

Number Component

1 Pogo Pins (5 sets total)

2 Septum (5 total)
zcentral.zcorp.com 15 All Rights Reserved
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1.12  LCD Menu And Control Knob (Control Panel)

1.12.1 Control Knob Operations

Push the Control Knob once to:

• Bring up the LCD menu.

• Select a menu item.

• Open a submenu.

• Start/Cancel/Stop a menu function.

Turn the Control Knob left or right to:

• Highlight a menu item. 

1.13  LCD Menu Overview

Main Menu

Vacuum

Depowder

Prep Build Chamber 

Status Report>

Printheads > 

Build Chamber >

Post Process Menu>

Go Online

Printheads Submenu

Main Menu >

Change Printheads

Align Printheads

Purge Printheads

Build Chamber Submenu

Main Menu >

Raise Platform

Lower Platform

Spread Layer

Fill Bed

Empty Build Chamber

Post Process Submenu

Main Menu

Post Process Heater

Post Process Filter
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1.14  Accessories Kit

1.15  Where To Go For More Information

Quick Start Guide  A Quick Start Guide is shipped with your printer Accessories Kit and will quickly get 
you printing parts. It has pictures and simple, step-by-step instructions to guide you through a print job. If 
you need an additional copy of the Quick Start Guide, an electronic copy is included on the ZPrint Installa-
tion CD. Or, visit our Web site at zcentral.zcorp.com.

Software User Manuals  User Manuals for the ZPrint and ZEdit Software programs are supplied on the 
Installation CD with the software. Additional copies are available on our Web site at zcentral.zcorp.com.

Top Level:

• Screwdriver

• Debris Separator

• Network (Ethernet) Cable (blue)

• Direct Connection Cable (red)

Not Pictured: 

• 3/16” Hex Key

• ZPrint/ZEdit CD

Middle Level:

• Large Syringe

• Grease Gun

• Tubing for Syringe

• Grease Gun Nozzle

• Grease Cartridge

• Water Bottle

Not Pictured: 

• Small Syringe

Bottom Level:

• Soft Bristle Brush

• Stiff Bristle Brush

• Vacuum Attachment

• Vacuum Attachment

• Medium Bristle Brush

• Vacuum Attachment

Your kit also includes a Welcome Letter, Quick Start 
Guide, and trays for transporting parts.
zcentral.zcorp.com 17 All Rights Reserved

10/21/08

https://zcentral.zcorp.com
https://zcentral.zcorp.com/index.php?option=com_content&view=article&id=103&Itemid=85
https://zcentral.zcorp.com/index.php?option=com_content&view=article&id=103&Itemid=85


ZPrinter® 650 Hardware Manual ZPrinter 650 Overview
Both programs include a searchable Help system and links to additional information on our User Web site 
regarding 3D applications and printing/post-processing techniques.

Post-Processing  Learn more about the different post-processing products that are available to use with 
your printer, on the Materials section of our User Web site at zcentral.zcorp.com.

Consumables  To order consumables/materials, visit ZShop at zshop.zcorp.com. 

If you are an international customer, you can order consumables directly from your local Service Provider 
or reseller.
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2 Setup And Print The Build
This section will show you how to use ZPrint to get your part ready to build, including adding fixtures and 
transforming the part. Then it will show you how to get your ZPrinter 650 ready and actually print your part. 

2.1  Overview To Printing Speed, Part Strength, And Part Accuracy
There are three important characteristics to 3D printing that will help you print the best parts for your 
intended purposes. Keeping these concepts in mind, you have the basis for becoming an expert 3D printer 
operator. 

• Part Placement = Printing Speed. The ZPrint Software automatically positions parts in the Build Bed 
for maximum build speed by placing parts with the smallest dimension in the Z-Axis. 

• Strength. The ultimate strength of an uninfiltrated part will be somewhat affected by its orientation 
within the Build Bed. The part will be strongest along the X-Axis and Y-Axis and less strong along the 
Z-Axis. This is because the cross sections are printed in continuous strips along the Y or the “fast” axis 
(the print heads’ direction of travel); in bands across the X or the “slow” axis (the fast axis direction of 
travel); and in laminated layers along the Z-Axis. Once a part is infiltrated, it uniformly takes on the 
strength characteristics of the infiltrating product.

• Accuracy. The accuracy of your part depends on how clean the printer is, your printer/powder set-
tings, and the materials you choose for post-processing. You can also employ features like Aniso-
tropic Scaling to adjust for expected shrinkage and bring your parts into true scale. More 
information on Anisotropic Scaling can be found in the ZPrint™ Software Manual.

2.2  Overview - Part Orientation
Parts that lie in the X-Y plane will be stronger than those aligned on the Z-Axis. If a part has a particularly 
delicate feature, especially one shaped like a thin rod, align that feature in the X-Y plane for the greatest 
strength. If a part has particularly delicate features that are supported only by unprinted powder, build a 
Fixture for the part to reduce the chances of breaking the feature during powder removal. See Section 2.9 
for instructions on how to create a Fixture.

Do not tightly pack multiple parts into the Build Bed. If multiple parts are tightly packed, it may be difficult to 
lift them out of the Build Bed with proper support. If a delicate part is being built with other more solid parts, 
add a Fixture to the delicate part to protect it during powder removal.
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2.2.1 Parts Containing an Opening or Hollow Area

Place the hollow side of a part facing down in the Build Bed to allow powder to evacuate during powder 
removal. Depending on how the part is imported into ZPrint, you may need to use the Rotate feature to 
correctly orient the part. Build parts that are delicate with a Fixture, to give them extra support and addi-
tional protection during powder removal. See Section 2.9 for instructions on how to create a Fixture.

An example of a part with hollow sides facing down

2.2.2 Parts Containing Overhangs

For delicate parts and parts with overhangs, create a Fixture, or create a Fixture for the area of the part 
that needs support. Unsupported overhangs are placed on the rear-most side of the Build Bed, as close to 
the bottom of the Build Bed as possible. See Section 2.9 for instructions on how to create a Fixture. 

An example of a part with two Fixtures to support the overhangs

2.2.3 Parts Containing Cylindrical Features

Cylindrical features will be more accurate when the cylindrical axis is parallel to the Z-Axis.
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The remainder of this chapter takes you through setting up your build in ZPrint and printing a part.

2.3   ZPrint/ZEdit Installation
If ZPrint has not been installed, you will first need to install it. Installation instructions are available in the 
ZPrint™ Software Manual. Be sure to install the software on the same computer that is connected to your 
3D Printer. Also be sure you use the version of ZPrint that came with the ZPrinter 650.

If you encounter any problems during installation, please contact your local Service Provider or Reseller, or 
visit the Support section of our Web site at zcentral.zcorp.com.

2.3.1 ZEdit

ZEditTM is an add-on software that ships with ZPrint. ZEdit was developed by a team of software develop-
ers and application engineers as a tool to help those who use HD3DP™ (high-definition 3D printing) to 
optimize their color applications. This software program works in conjunction with the ZPrint software. Use 
ZEdit to apply color or labels to your part, as well as to diagnose and correct simple file problems. Color 
may be applied to a part through the application of a texture map, engineering template, text, or by using 
the paint features.

Customers should install ZEdit when ZPrint is installed. See the ZPrint™ Software Manual for installation 
instructions. Refer to the ZEdit™ Software Manual, or the ZEdit Online Help, for specifics about using this 
software.

2.4  Open A Part In ZPrint
1. Launch the ZPrint Software. The Splash screen will close on its own after a few seconds, or you can 

click the OK button to immediately close the screen.

2. In the Open dialog, select a file to print, or browse to a file on your computer. Click the Open button, or 
double click on a file to open it in ZPrint.
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3. If the Choose Units dialog opens, choose the display units that correspond to the part dimensions and 
then click Next. The file is opened in a new ZPrint window using the units specified in this dialog.

4. If you would like to add additional files to the build, select File > Import and select more files. By 
default, ZPrint will position each file in the Build Bed for the fastest print time. 

2.5  ZPrint Main Window
See the ZPrint™ Software Manual for a complete description of the Main Window. 

2.6  Check Or Change The Default Printer Settings
1. Select Settings > Printer Settings to display the Default Printer Settings dialog.

2. In the Default Printer Settings dialog, check that the default printer is the printer that is connected to 
your computer. 

• If it is not, click Select Printer and proceed with Step 3.

• If it is, click Cancel and skip the rest of this procedure.
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3. In the Select 3D Printer dialog, choose Network as the Port Type. Click the Find button to locate the 
printer on the network. If the printer is connected to the network, it will appear on the list. Select the 
printer and click OK. 

4. The Default Printer Settings dialog reopens showing your new default settings. To save your set-
tings, click the Save As Default button. You can change these settings at any time by repeating Steps 
1 - 4.
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2.7  Check The Default Powder Settings
1. Select Settings > Powder Settings to display the Powder Settings dialog.

2. Select the printer and the powder type from the left-side panel to view the settings for that combination. 

• ZPrint defaults to the recommended powder settings for the Layer Thickness, Saturation Lev-
els, Binder/Volume Ratio, Bleed Compensation, Anisotropic Scaling and Fixture Clearance.

Important: Most of the powder settings cannot be changed, but you can override the settings for 
the Layer Thickness, Bleed Compensation, Anisotropic Scaling, and the Fixture Clearance 
for the current build only. We do not recommend changing these, but should you need to:

• Select File > 3D Print Setup to disable the Bleed Compensation, or to change the Layer Thick-
ness. 

• Select Transform > Anisotropic Scaling to change the values for Anisotropic Scaling. 

• Select Edit > Make Fixture to change the Fixture Clearance amount. This value is the smallest 
amount of space between the Fixture and the part, without actually touching.

2.7.1 Create A New Powder Type

You can create a new powder type and enter new data in the fields that are activated in the Powder Set-
tings dialog. The new settings must be saved under a unique powder name and will be added to the left-
side panel after saving. See the ZPrint™ Software Manual for complete instructions on how to create a 
new powder type.

2.8  Transform The Part in ZPrint
The ZPrint Transform menu has several options for transforming parts. Following is a brief overview to 
help familiarize you with some of these options. For a complete description of the Transform menu, please 
refer to the ZPrint™ Software Manual.
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ZPrint Transform Menu

  Translate 

Positions the selected part by the amount specified 
for the X, Y, and Z coordinates. The default values of 
0,0,0, represent the lower-left corner of the Build 
Bed.

  Rotate 

Rotate/Rotate Group - Rotates the selected part in 
the specified plane (view).

Select your part (left-click on the part in ZPrint) and 
select Transform > Rotate. Select the plane (view) 
to rotate the part in and then enter the degree of 
rotation in the degrees field. 

Enter a negative value to rotate the part clockwise 
by that amount.

  Scale 

Scale/Scale Group - Scales the selected part by 
the dimensions specified in the Relative or the X, Y, 
and Z fields. 

Select the part. Select Transform > Scale. Limit the 
scale to the maximum limits of the build area -10 x 
15 x 8 inches. 

(254 mm x 381 mm 203mm).
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2.9  Fixtures
A Fixture is a grid-shaped object with a top surface between the bottom-most surface of the part, (without 
actually touching the part), and the bottom of the Build Bed. Generate a Fixture under a part, or a portion of 
a part, to create a “cradle” that is easily handled during transport, depowdering and post-processing. An 
optional bumper feature is available to provide additional protection during automatic powder removal for 
especially delicate parts, or multiple parts in the same build. 

NOTE: ZPrint will evaluate the geometry of the part and build the smallest Fixture necessary, with 
minimum use of materials.

  Mirror 

Mirror/Mirror Group - Mirror a part in the X, Y, or Z 
direction.

Select your part. Select Transform > Mirror. 
Choose a direction to mirror the part.

  Justify 

Justify/Justify Group - Aligns or “justifies” the 
selected part to a specified location in the Build Bed. 
Options include Left/Right, Front/Back, and Bot-
tom of the Build Bed. 

Select the part. Select Transform > Justify. 
Choose your settings.

If a part extends outside of the Build Bed, ZPrint 
prompts you with a warning message and outlines 
the part with a red wire frame. You can manually 
adjust the position of the part with your mouse, or 
you can use the Justify dialog.

Undo - Select to undo your last transformation 
action. 

• Undo works for the last action taken. You 
cannot undo multiple actions. 

• Undo only applies to the commands on the 
Transform menu.
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You can generate a Fixture for an entire part, for a portion of a part, or for a part feature that needs addi-
tional support. Fixtures also provide these benefits:

• Supports parts during powder removal process.

• Supports delicate, thin parts for easy removal from the printer and handling during post-process-
ing.

• Keeps multiple parts from bumping into each other, or into the Build Bed walls during powder 
removal.

• Increases accuracy in the Z-Axis for parts with large overhangs. 

• Helps prevent “squash” effects for hollow cylindrical parts, or parts with overhangs. 

NOTE: Squash effect results from an overhang being supported with only unprinted powder. For 
example, if a part is a hollow round cylinder, such as a scope, the weight of the powder above the cyl-
inder will cause it to “squash” to something less than round, if there is no support underneath.

2.9.1 Create a Fixture for an entire part
1. Select the part in ZPrint.

2. Select Edit > Make Fixture. ZPrint orients the part in the 3D View for building the Fixture.

NOTE: The settings in the Make Fixture dialog are the General Preference settings that are preset in 
the software and the recommended settings for the printer. See the ZPrint™ Software Manual for a 
description of the Make Fixture dialog should you need to change any of these settings. 

3. There are two features you may choose to enable for a Fixture:

• Make Bumper: To add a bumper to a fixture, check the Make Bumper check box. A bumper will be 
generated on the Fixture base.

• Holes between walls: Powder may get trapped between the Fixture and the part. You can gener-
ate a Fixture with holes at the grid intersections to allow powder to escape during automatic pow-
der removal. A zero (0) in this field means no holes are generated on the Fixture. The higher the 
percentage, the larger the holes will be on the Fixture. 
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4. Click OK. The Fixture is generated.

    The fixture is shown in white on the screen.  

5. Select View > Collision Detection to ensure the Fixture is not touching the part. If the Fixture is touch-
ing the part, do the following:

• Select the fixture and press Delete on your keyboard.

• Open the Make Fixture dialog and increase the Accuracy Coefficient value by 1 (one).

• Click OK to regenerate the Fixture.

• Run Collision Detection again.

2.9.2 Create a Fixture for a portion of a part
1. Select the part in ZPrint. ZPrint orients the part in the 3D View for building the Fixture.

2. Select Edit > Make Fixture.

3. In the 3D View, click on the wire frame in the top, left corner, press Shift and drag the box to an area of 
the part that you want to support.

• To Resize: Click on the box and drag the mouse to resize the box.

• To Rotate: Click on the box, press Ctrl and drag the mouse to rotate the box.
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4. When you have positioned the box, click OK in the Make Fixture dialog. The Fixture is generated for 
the specified area.

The fixture is shown in white on the screen.

2.10  Check the Build Layers for Errors or a Collision
It is strongly recommended that the Slice View (2D icon) and Collision Detection be utilized before 
beginning a build. 

• The slice view is toggled on the ZPrint 3D View menu when you select the Switch Layer View / 
3D View command, or by selecting the 2D icon on the Toolbar. When printing single or multiple 
parts, slice viewing allows you to view the cross sections of the part(s) to identify any errors in the 
file. 

• Collision Detection is located on the ZPrint View menu. When printing multiple parts, or a part with 
a Fixture, always run Collision Detection to scan through the slices and see where layers of a part 
may be overlapping or touching another part, or the Fixture. 

2.11  Check The Build Settings 
Before printing, always check your build settings.

1. Select File > 3D Print Setup, or click  on the Toolbar. 
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2. Check that the printer listed in the Select Printer field is the printer connected with the computer run-
ning ZPrint, and that the printer is Online. 

• If the printer is Offline, the Select Printer field will display Offline beside the printer name. Click the 
Select Printer button to locate an Online printer via a Network connection.

3. Bleed Compensation is checked (On) by default. For most ZPrinter 650 users, the Bleed Compensa-
tion setting should not be unchecked (Off) except in a couple of special situations: 

• If you are building a part for visualization purposes only, uncheck Bleed Compensation so the part 
will build with slightly thicker dimensions for added strength. 

• If your part is a complex assembly containing many shells and you can see lines between the 
shells, or if the part tends to break at the shell boundaries, uncheck Bleed Compensation to weld 
together the places in the assembly that are slightly touching. Leaving Bleed Compensation 
checked will tend to create fracture lines between abutted sections.

4. Click OK.

2.12  Prepare the Build Area
Go to your printer and check each item listed below to ensure the printer is ready to print. It is important to 
check each of these items before every build. 

• Check that the Deck, Fast Axis, and Build Bed are clean of any powder. See Section 3.1 for 
instructions on how to vacuum up excess powder from these areas.

• Check that the Debris separator is empty. See Section 3.2 for instructions on how to empty the 
Debris separator.

• Check that Parking Caps are clean. See Section 3.3 for instructions on how to clean the Parking 
Caps.

• Check that Carriage and Rails are clean. See Section 3.4 for instructions on how to clean the Car-
riage and Rails.

• Check that Service Station is clean. See Section 3.5 for instructions on how to clean the Service 
Station.

• Check that the platform is raised to the top of the Build Bed. Select PREP BUILD CHAMBER > 
CONTINUE on the LCD menu to raise the platform to its proper position.
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A clean, properly prepared Build Bed

2.13  Print the Build

1. Select File > 3D Print, or click  on the Toolbar, to display the Printer Status dialog.

NOTE: ZPrint checks the printer readiness and calculates the materials needed to complete the 
build. The results are reported in the Printer Status dialog for you to check before starting the 
build. 

• The dialog shows OK for each item and the Print button is enabled when the printer is ready. 

• If you see a message and the Print button is not available for selection, see Chapter 5 - Additional 
Operations for instructions on how to clear a message.

2. Choose your options for the build in the Print Job Options section of the Printer Status dialog.
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• Print in Monochrome - Prints a color part in monochrome (no color). Printing in monochrome 
speeds up the print time and is useful for prototypes that do not require color for evaluation.

• Preheat Build - Delays starting the print job until the printer has reached its full temperature.

• Check that Service Station is clean. See Section 3.5 for instructions on how to clean the Service 
Station. - Opens a dialog where you enter a specific time to start a print job.

• Empty Build Piston After Printing - Checked by default. When checked, the printer will automat-
ically remove the bulk of the powder from the Build Bed after the part has printed and dried. (Auto-
matic Powder Removal)

Important: If you want to utilize the automatic powder removal feature and you are printing a delicate 
part, build a Fixture for the part. 

3. Check the Printer Status window to see what is currently displayed on the printer LCD menu. The 
printer must be Online before you can start the print job. 

4. When all of the items in the Print Heads, Powder, and General sections show OK, the Print button is 
enabled. Click Print to start the build. Before starting the build, the printer will: 

• Service the print heads

• Fill the Build Bed with powder and then spread one layer to make the top surface smooth

NOTE: The printer allows you to start a build if a Head Alignment will be performed, or if the 
Build Temperature is warming up. 

5. The Printing dialog opens and tracks the following information for the duration of the build:

• Estimated Finish Time

• Estimated Time Remaining

• Layer% Completion status bar

• Starting Time

• Elapsed Time

• Pause Button - Click to pause the build. Click again to resume the build

• Cancel Button - Click to cancel the build

• Cross-section view (2D) of the current build

• Part orientation of the current build as it is printing, in the X-Z Axis (side view)
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2.14  Dry The Part
When your part is finished printing, the printer runs a drying cycle. A timer on the LCD menu will count-
down the time remaining to dry the part. Drying the part gives it added strength, so you should not handle 
parts before they have adequately dried. 

• You can leave the part in the Build Bed after the drying cycle ends and it will continue to increase 
in strength. The longer a part is dried the stronger it becomes, although until it is infiltrated, it will 
still be fragile and should be handled with care. 

2.15  Automatic Powder Removal
Your part prints and dries in the Build Bed surrounded by unused powder. There are three ways to 
remove unused powder from the Build Bed after the drying cycle is finished:

• Unused powder is automatically removed from the Build Bed when the Empty Build Piston After 
Printing option is checked in the Printer Status dialog.

• If you unchecked the Empty Build Piston After Printing option but would still like to utilize this 
feature, you may do so at the printer. Select BUILD CHAMBER > EMPTY BUILD CHAMBER 
on the LCD menu to start the Automatic Powder Removal cycle.

• If you unchecked the Empty Build Piston After Printing option, you can manually excavate the 
part by vacuuming powder away using the vacuum hose. Check the part orientation in ZPrint 
before you begin vacuuming.

Important: For delicate parts, or parts with especially delicate features, it is recommended that you 
build the part with a Fixture when using the Automatic Powder Removal feature. 

If a part is too delicate to handle the low-level vibration during the Automatic Powder Removal cycle, 
uncheck the Empty Build Piston After Printing option and manually excavate the part using the vac-
uum hose.
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NOTE: Unused powder that is emptied or vacuumed from the Build Bed is recycled back into the 
printer Feeder so it can be used for future builds. 

2.16  Fine Powder Removal
After the bulk of the powder is removed from the Build Bed, gently pick up the part and place it in the Post-
Processing Unit where you clean the part of any remaining powder with the Air Wand. 

1. Open the printer top cover. 

2. Select BUILD CHAMBER > RAISE PLATFORM on the LCD menu. Hold the Control Knob down to 
raise the platform closer to the top of the Build Bed. 

3. Gently lift the part and place it in the Post-Processing Unit.

4. Close the top cover of the Post-Processing Unit and select DEPOWDER on the LCD menu to start the 
air compressor.

5. Slide your arms into the chamber through the two openings and remove the Air Wand from its clip. 

• Test the air pressure against your hand before applying air to the part. Adjust the pressure by turn-
ing the brass control nut located at the junction between the Air Wand and its air hose.

• Use light pressure for delicate or thin-walled parts. If the air pressure is too strong, you run the risk 
of breaking a feature.

6. Apply air to the part to clean off all remaining powder. 

Best Practices For Vibrant Colors: Brushing your part before infiltration will greatly enhance its color. 
Go over the part using the 2" Soft Bristle Brush, the double-ended Stiff Bristle Brush, or the Medium 
Bristle Brush that is shipped with your printer Accessories Kit. Not every part will look like it needs 
brushing, but every part will benefit from brushing and will assure the best possible finished part. After 
brushing the part, use the Air Wand to remove any remaining powder on the part.

        

Refer to the Color Quality Best Practices document on our Web site for complete information (zcen-
tral.zcorp.com).

Best Practices For Cleaning: When finished, use the Air Wand to quickly clean the Post-Processing 
Unit of all powder. Apply air around each side of the chamber and the backside of the top cover to 
remove any excess powder.

7. Turn the air compressor off by pushing the Control Knob once and return the Air Wand to its clip. 
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2.17  The Next Step
Right now - after depowdering and before post-processing - while the part continues to dry, take a few min-
utes and clean the printer. 

Regular cleaning and maintenance is the simplest, best way to ensure your parts look their best, 
and to keep your printer running trouble-free.

See Section 3, ’Routine Cleaning’ for complete details on how to perform these routine cleaning tasks.

 After you have cleaned and prepared the printer for the next build, proceed with the Post-Processing steps 
in Section 4, ’Post-Processing With Z-Bond’.
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3 Routine Cleaning
This chapter describes the routine cleaning you should complete after every build. This will prepare the 
printer for the next build and keep the printer running smoothly and problem free. These tasks take only a 
few minutes to perform but make a huge difference in how well your printer runs. 

• Section 3.1, ’Vacuum Excess Powder’

• Section 3.2, ’Empty The Debris Separator’

• Section 3.3, ’Clean The Parking Caps’

• Section 3.4, ’Clean The Fast Axis Rails and Carriage’

• Section 3.5, ’Clean The Service Station’

3.1   Vacuum Excess Powder
After every build, vacuum up all loose powder in the Build Chamber, including the Build Bed, Deck, and 
Fast Axis including the Rails and Carriage. To vacuum:

1. Select VACUUM on the LCD panel. 

2. Open the printer top cover and remove the vacuum hose from its stand.

3. Vacuum any excess powder in the Build Bed, around the Deck, and on top of the Fast Axis. Pull the 
Fast Axis forward and check for powder towards the back of the Build Chamber as well.

• You can leave powder in the Feeder (the area behind the Build Bed where powder is spread to the 
Build Bed), but the powder remaining in the Build Bed after a print job should be vacuumed.

4. The vacuum will stop automatically after a couple of minutes, or you can push the Control Knob once 
to shut off the vacuum. When you are finished, return the hose to its holder.
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3.2  Empty The Debris Separator
After vacuuming, empty the Debris Separator. The Debris Separator catches any large particles and keeps 
those pieces from being recycled into the feeder. To empty the Debris Separator follow the steps below.

1. Pull the Debris Separator out of its holder on the printer.

2. Empty the contents into a trash receptacle.

3. Use the soft brush found in the Accessory Kit to brush any caked-on powder from the screen.

4. Return the empty Debris Separator to its holder. Be sure to push the Separator flat against the panel 
for a secure fit.
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3.3  Clean The Parking Caps
The Parking Caps keep the print heads from drying out between print jobs. Cleaning the Parking Caps 
after every build results in longer lasting print heads and precise accuracy during printing. 

The Parking Caps are located on the right end of the Fast Axis. 

Before you begin:

• Get several dry paper towels.

• Get the squirt bottle included in your Accessories Kit.

• Fill the squirt bottle with distilled water.

• Wear disposable gloves.

1. Pull the Fast Axis toward you and slide the Printhead Carriage to the left to expose the Parking Caps.

2. Lay paper towels on the Build Bed under and around the Parking Caps. 

3. Cover the Front Overflow with paper towels.
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4. Squirt the distilled water onto the Caps. The water should drain out through the Spittoon under the 
Caps.

5. Use a dry paper towel to wipe the caps clean.

6. Remove the paper towels from the Build Bed and Deck. Wipe up any water on the Build Bed, Fast Axis 
or Deck.

7. Remove the paper towels from the front overflow and dry it thoroughly.

8. Vacuum the Build Bed and Deck remove any powder dislodged from the Rails or Carriage. 

9. Be sure the Parking Caps are completely dry before starting your next build.

Note: If the Caps are very dirty, or if washing them as above is not sufficient, then remove the Caps from 
the printer and wash them under running water. Dry them thoroughly before reinstalling them in the Fast 
Axis.
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3.4  Clean The Fast Axis Rails and Carriage
Keeping the Fast Axis Rails and Carriage clean will keep the Carriage moving smoothly and thus optimize 
printing accuracy.

1. Pull the Fast Axis toward you.

2. Using a paper towel dampened with distilled water, wipe the top and bottom Rails to remove any pow-
der. Move the Carriage back and forth as needed to clean the entire length of both rails. 

3. Dry the Rails thoroughly using a clean dry paper towel.

4. Using a fresh paper towel, wipe the Carriage to remove any powder.

5. Wipe or vacuum the Build Bed and Deck as needed to remove any powder dislodged from the Rails 
and Carriage.

Number Component

1 Bottom Rail

2 Top Rail
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3.5  Clean The Service Station
The function of the Service Station is to clean the print heads during printing. Clean the Service Station 
after every build to remove residue buildup and to ensure the printer runs optimally for your next print job.

Before you begin:

• Get several dry paper towels and a cotton swab.

• Get the squirt bottle filled with distilled water.

• Wear disposable gloves.

• Get the Pick and Small Syringe from the Accessories Kit.

3.5.1 Example - Dirty Service Station

Number Description

1 Spit Plate

2 Squeegee

3 Wash Holes

4 Powder Residue

5 Ink, Binder Residue

6 Powder Residue
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3.5.2 Example - Clean Service Station

3.5.3 Cleaning Procedure
1. Place paper towels around the Service Station, and between the Service Station and the Build Bed.

2. Cover the front overflow with paper towels.

Number Description

1 Wash Holes Clean and Open

2 Squeegee Clean and Dry

3 Spit Plate Clean 

4 Housing Clean

5 Overflow and Build Bed Clean
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3. Position the squirt bottle close to the station and squirt water on and around the squeegee.   

4. Use the cotton swabs or a paper towel and wipe the front and back of the squeegee. Use the Pick to 
scrape excess powder out of any corners. 

5. Lift the spit plate up off the Service Station and clean it with a paper towel.    
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6. Wipe off any water or cleaning solution on the Wash Holes. Thoroughly wipe the Service Station clean. 

7. Install a needle onto the small syringe. Gently push the tip of the needle through each of the six Wash 
Holes to clear them.   

8. Wipe up any water that may have spilled onto the Deck or Build Bed.

9. Replace the spit plate, using the edge tabs for correct alignment. 

10. Close the printer top cover.
zcentral.zcorp.com 45 All Rights Reserved

10/21/08

https://zcentral.zcorp.com


ZPrinter® 650 Hardware Manual Post-Processing With Z-Bond
4 Post-Processing With Z-Bond
This section describes post-processing a part using Z-Bond™ Instant Infiltrant. The infiltrant soaks into the 
newly-printed part and bonds the printed powder together. This both strengthens the part and creates more 
vibrant colors.

Z-Bond is available in larger bottles for use in the dipping method. For parts with 
delicate features, smaller bottles of Z-Bond are available for drizzling onto a part. 

Note: At this time, Z-Bond 90 and Z-Bond 101 are the only infiltrants approved for 
use inside the PPU of the ZPrinter 650. 

We’re always testing new materials and combinations, so check our Web site for 
the latest complete information regarding post-processing materials, techniques, 
Best Practices, and material storage guidelines. All this information, plus shop-
ping for consumables, is at zcentral.zcorp.com. 

Safety Precautions

• Read and understand the Material Safety Data Sheet before using or handling this product.

• Wear a lab coat or smock, gloves, face shield, or goggles. 

• Apply in a well-ventilated area or inside the Post-Processing Unit.

• Specialized containers are recommended for applying Z-Bond. Have a catch pan, waxed paper, or 
plastic drop cloth available for catching spills.

• Label disposal materials and dispose of according to the label instructions.

• Wear a dust mask when sanding finished parts.

• Z-Bond reacts with water and ambient moisture. Once a bottle has been opened, it is recom-
mended that the product be used within 30 days. Avoid all contact with water and avoid use under 
high humidity conditions. If Z-Bond is exposed to excessive humidity, it will thicken up and become 
unusable for infiltration.

• Store Z-Bond in a cool, dry area.

4.1  Preparation
We recommend using the Post-Processing Unit to infiltrate your part. Before you begin infiltrating your 
part, make sure the part is completely free of powder. See Section 2.16, ’Fine Powder Removal’. Follow 
these preparation guidelines:

• Wear a lab coat or smock, safety glasses, and a pair of the high quality gloves from the Startup Kit 
(or 2 pairs of lightweight disposable gloves).

• Place a piece of wax paper over the metal Post-Processing Tray to keep it clean.

• Use a dipping container large enough to fully submerge your part.

• Have paper towels ready for absorbing excess fluid.

• Ensure the part is completely dry before applying Z-Bond.

In addition, if you are not using the Post-Processing Unit, we recommend the following:

• Work in a well-ventilated area.

• Place a piece of cardboard down in your work area and place a piece of wax paper over the card-
board for the part to dry on.

Z Corporation also offers a Z-Bond 101 Dipping Kit, which contains all the supplies needed for post-pro-
cessing. The Kit provides a convenient and cost-effective way to get everything you need.

Please visit our Web site for more information or to purchase your supplies: zcentral.zcorp.com
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4.2  Using the Post-Processing Unit
The Post-Processing Unit provides a convenient way to infiltrate parts without having to move the part to a 
separate work area. Follow the steps below to set up the Post-Processing Unit for infiltration.

CAUTION

The Post-Processing Unit is for use with Z-Bond only. Do not use with any other 
Infiltrant. Do not use with spray paint of any kind, or with any flammable spray.

Check the Materials section of our Web site for the latest complete information regarding post-processing 
materials, techniques, Best Practices, and material storage guidelines: zcentral.zcorp.com.

1. Pull down the Accessory Tray Arm.

2. Slide the Accessory Tray onto the Arm

.

3. Place the part on the Accessory Tray.

4. Unlatch the metal tray from inside the top of the Post-Processing Unit. 
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5. Lower the metal tray to the bottom of the Post-Processing Unit and press down to snap it in place.

6. Turn on the carbon air filter to capture any fumes from the infiltration. On the LCD Menu, select POST 
PROCESS MENU, then POST PROCESS FILTER and TURN ON.

4.3  Post-Processing Using the Dipping Method
Most parts can be infiltrated simply by dipping briefly in the Z-Bond, then allowing the part to dry. Be sure 
the part is completely dry and free of powder before infiltrating.

1. Place the wax paper near the container and pour enough 
Z-Bond into the container to completely submerge the 
part.

2. Gently submerge your part into the liquid. 

3. Look for bubbles rising. If you don’t see any, let the part sit 
submerged for about 10 seconds and then remove it from 
the liquid. 

4. If you see bubbles rising, wait until the bubbles stop and 
then remove the part.

5. Keep the part moving in your hands so it does not stick to 
your gloves.

Note: The part will get very warm and may emit visible vapor. These are normal by-products of the cur-
ing process.

6. Quickly and thoroughly wipe any excess liquid off the part with the paper towels and place the part on 
the wax paper. 

7. Do not let excess liquid pool on the part as this may cause its texture to change.

8. Move the part frequently for the first few minutes. This prevents pooling of Z-Bond under the part and 
the part adhering to the paper.

9. Let the part dry and cool at least 30 minutes before handling further.

10. Return any unused Z-Bond to its bottle for reuse. 

4.4  Post-Processing Using the Drizzle Method
Parts with delicate features may be damaged by the handling required for the dipping method. In these 
cases, apply Z-Bond using the small bottle and its spout. Be sure the part is completely dry and free of 
powder before infiltrating.
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1. Place wax paper where you will be working.

2. Open the bottle and attach the spout.

3. Drizzle Z-Bond onto the part. Start with the most delicate 
areas first. Wet as much of the part as you can easily 
reach.

4. Reposition the part and repeat this process until the 
entire part is infiltrated. 

5. Quickly and thoroughly wipe any excess liquid off the 
part with the paper towels and place the part on the wax paper. 

6. Do not let excess liquid pool on the part as this may cause its texture to change.

7. Move the part frequently for the first few minutes. This prevents pooling of Z-Bond under the part and 
the part adhering to the paper.

8. Let the part dry and cool at least 30 minutes before handling.

QSG-24
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5 Additional Operations
When you start a print job, ZPrint checks the printer to ensure there are enough materials to complete 
the job and that the printer is properly prepared before starting the job. If the printer does not have 
enough powder, binder, or print head life to complete the job, a message appears in the Printer Status 
dialog telling you what you need to do to prepare the printer before printing. 

Important: Do not add powder or binder to the printer, or change a print head, unless you see a mes-
sage telling you to in the Printer Status dialog. 

• Section 5.1, ’The Printer Status Dialog’   

• Section 5.2, ’Change Print Head(s)’   

• Section 5.3, ’Add Binder’ 

• Section 5.4, ’Add Powder To The Feeder’

• Section 5.5, ’Add Cleaning Solution’

• Section 5.6, ’Replace the Waste Tray’

• Section 5.7, ’Position Build Piston (Build Bed)’

5.1  The Printer Status Dialog
The Printer Status dialog keeps you appraised of everything your ZPrinter 650 needs to start your print 
job. The two examples below show what appears when the printer is ready to print, and when it’s not 
ready.

5.1.1 Ready to Print 
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In the example above, the Printer Status dialog shows the printer is ready for printing. Notice that 
each item shows OK, and the Print button is enabled. From here you would choose your printing 
options and click Print to start the job. Before the printer starts printing your file, it will first: 

• fill the Build Bed with powder

• spread a layer to ensure the Build Bed surface is smooth

• service the print heads

• run an auto-alignment if a print head was replaced after the previous build

5.1.2 Not Ready to Print 

If there are not enough materials to complete the job, or the printer is not properly prepared, a mes-
sage appears similar to the examples in red above. When any one of these messages appears, the 
Print button is disabled. The remainder of this chapter describes how to clear a message in the 
Printer Status dialog and start the build. 

ZPrint allows you to continue and print if:

• The printer build temperature is still warming up.

• A Head Alignment will be performed. The Head Alignment runs before the part begins to print. 
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5.2  Change Print Head(s)
If the Printer Status dialog indicates one or more print heads needs changing, follow the steps below.

1. On the Control Panel select BUILD CHAMBER, then LOWER PLATFORM. Continue holding in the 
Control Knob until the build bed is about 6” below the top. 

2. On the printer’s LCD menu, select PRINT HEADS then CHANGE PRINT HEADS. The fast axis 
moves to the service position. 

3. Wet a paper towel with distilled water and wipe off the Alignment Sensor Window on the underside of 
the Carriage. The Alignment Window is located on the front left corner of the Carriage, under the bun-
dle of print head tubes. 

Note: Don’t wipe the bottoms of the print heads.

4. Dry with a clean paper towel. 

5. Open the carriage cover by releasing the two latches.
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6. Lift the print heads to be replaced out of their slots and properly recycle or dispose of any empty car-
tridge(s).  

7. Get an alcohol swab (included with your Startup Kit). Snap it to break the glass inside, and squeeze 
the tube to saturate the swab

.

8. For each printhead being replaced, wipe off all the pogo pins (inside the carriage) with the alcohol 
swab. Use additional swabs if needed. 
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9. Remove the new printhead from its packaging. Be sure to pull the tape tab off of the new printhead.

10. Insert each new printhead. Press down firmly on the top of the printhead, at the same side as the pogo 
pins, to securely fit a printhead into its slot.
 

11. Close the carriage cover by pressing down until you hear it click shut. Be sure both latches are 
engaged.

12. Close the printer top cover. Select CONTINUE then EXIT on the LCD. 

13. The fast axis reparks and the printer goes Online. The printer purges the new printheads and runs an 
auto-alignment pattern before the next print job to properly align the print heads.
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5.3  Add Binder
If there is not enough binder in one or more of the cartridges, ZPrint displays BINDER LOW in the Printer 
Status dialog. 

Important: Do not add binder unless you are prompted to in the ZPrint Printer Status dialog.

To add binder, follow the steps below.

1. Pull the empty binder cartridge out of its housing on the printer. 

2. Get a new binder cartridge. Check the expiration date, and check the cartridge label for the correct 
color and orientation. Match the cartridge color to the color label on the printer. 

3. Insert the cartridge into its housing with the color marking on top. Ensure the cartridge is pushed all the 
way in. You should feel it gently snap into place. 

Important: If a cartridge does not snap into place, do not force it. Check the orientation and that it is 
the correct color and try again.
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5.4  Add Powder To The Feeder
ZPrint evaluates the geometry of the part to determine if there is enough powder in the Feeder to complete 
the build. If there is not enough powder, ZPrint displays ADD POWDER in the Printer Status dialog. 

Important: Do not add powder to the Feeder unless you are prompted to in the ZPrint 
Printer Status dialog.

To add powder, follow the steps below.

1. Before unsealing the powder canister, turn it upside down and shake to loosen the powder inside. 

2. Check the expiration date on the canister.

3. Open both top covers and place the powder canister in the Post-Processing Unit. 

4. Remove the gray sealing cap from the top of the canister.

5. Insert the vacuum hose into the hose fitting located on top of the canister. 

6. Select VACUUM on the LCD menu. The vacuum automatically shuts off when the Feeder is full, or the 
canister is empty. When the Feeder is full, the LCD displays FEEDER FULL. 

TIP: To check that powder is getting into the Feeder, look at the Debris Separator. You will see powder 
moving through the window when the vacuum is running.

7. Remove the powder canister and return the vacuum hose to its stand.
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5.5  Add Cleaning Solution
If there is not enough cleaning solution, ZPrint displays ADD CLEANING SOLUTION in the Printer Status 
dialog. 

Important: Do not add cleaning solution unless you are prompted to in the ZPrint Printer Status 
dialog.

To add cleaning solution, follow the steps below.

1. Open the lower door (under the Build Chamber).

2. Pull the empty cleaning solution cartridge out of its housing on the printer. 

3. Get a new cleaning solution cartridge. Check the expiration date, and check the cartridge label for the 
correct orientation. 

4. Insert the cartridge into its housing. Ensure the cartridge is pushed all the way in. You should feel it 
gently snap into place. 

Important: If a cartridge does not snap into place, do not force it. Check the orientation and that it is 
the correct type and try again. 

5.6  Replace the Waste Tray
If the Waste Tray is Full, ZPrint displays EMPTY WASTE TRAY in the Printer Status dialog. 

To replace the Waste Tray, follow the steps below.

1. Open the lower door (under the Build Chamber).

2. Pull the full Waste Tray out of its compartment on the printer. 

3. Insert a new Waste Tray into its compartment. Ensure the Tray is pushed all the way in.  
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5.7  Position Build Piston (Build Bed)
The Build Bed platform must be in its proper position at the top of the Build Bed in order for the printer to fill 
the bed and spread a layer of powder before starting a print job. If you see the message RAISE BUILD in 
the Printer Status dialog, go to the printer and select PREP BUILD CHAMBER to raise the platform to 
its proper position.

5.8  Cover
The printer cannot start a print job when the top cover is open. If the top cover is open, go to the printer and 
close it. Do not open the cover while the machine is printing.
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6 Printer Maintenance
This chapter details how to perform maintenance on your printer and how to prepare your printer for stor-
age if you will not be running it for extended periods. Most of these procedures are only performed when 
you are prompted to in the ZPrint Maintenance dialog. Others should be performed at the recommended 
frequency detailed in each procedure below.

• Section 6.1, ’Fast Axis Bearing Lubrication’

• Section 6.2, ’Piston Screw Lubrication’

• Section 6.3, ’Slow Axis Bearing Lubrication’

• Section 6.4, ’Replace the Carbon Filter’

• Section 6.5, ’Clean The Alignment Sensor Window’ 

• Section 6.6, ’Clean The Fast Axis Pulleys’

• Section 6.7, ’Clean The Slow Axis Rails and Pulleys’

• Section 6.8, ’Clean The Spreader Roller’

• Section 6.9, ’Printer Storage Preparation’

The Maintenance dialog (found on the ZPrint Service menu) keeps a record of when the Fast Axis bear-
ing, the Slow Axis bearing, and the Piston Screw require lubrication. ZPrint will prompt you when lubrica-
tion of any of these components is required. Only lubricate these components when you are prompted to in 
ZPrint.

While lubrication of these items is important, it is equally important not to over-grease the bearings and pis-
ton screw when lubricating. Only a very small amount of grease or oil is required to keep these parts work-
ing optimally. Over-lubricating creates a situation where lubricant builds up in places where it should not 
be, and may cause the printer to report an error. 

6.1  Fast Axis Bearing Lubrication
Frequency: When prompted in ZPrint, or when you receive Error 2303-1.

1. Open the printer top cover and pull the fast axis forward until it stops.

2. Lay clean paper towels under the left end of the Fast Axis. 

3. Cover the Front Overflow with paper towels.
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4. Using a paper towel dampened with distilled water, wipe the top and bottom Rails to remove any pow-
der. Move the Carriage back and forth as needed to clean the entire length of both rails.

5. Dry both Rails thoroughly with a clean dry paper towel.

6. Using a fresh paper towel, wipe the Carriage to remove any powder.

7. Locate the Fast Axis oiling hole, located in the top of the Fast Axis near the left end.

8. Make sure there is no powder visible inside the hole or on top of the Fast Axis.

9. Lift up the hinged cap that covers the oiling hole.

10. Using the oil supplied in your Accessories Kit, place 5 drops of oil into the small reservoir. Do not over-
fill. Close the cap. 

11. Slide the Carriage back and forth to distribute the oil evenly over the Rails.

12. Reset the Maintenance Counter in ZPrint.

6.2  Piston Screw Lubrication
Frequency: When prompted to in ZPrint.

1. Remove the back cover panel of the printer. 

2. Remove the side panel.

3. On the LCD display, select BUILD CHAMBER > LOWER PLATFORM. Hold the Control Knob down 
and lower the Build Bed platform as far as you can to expose the entire length of the piston screw. 

4. Assemble the grease gun that is part of your Accessories Kit according to the instructions found in the 
document 09576 Grease Gun Loading Instructions, which is supplied in the materials that were 
shipped with the printer. You can also find these instructions on our Web site at zcentral.zcorp.com.

Number Component

1 Oil Reservoir

2 Oil Reservoir Cap
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5. Look into the left end of the printer, in between the Waste Tray and the pocket for the Cleaning Solution 
Cartridge and locate the piston screw.

6. Reach into the left end of the printer and wipe the Piston Screw clean of old grease, dust, etc.

Number Component

1 Waste Tray

2 Piston Screw

3 Pocket for Cleaning Solution 
Cartridge
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7. Touch the grease gun to the Piston Screw and squeeze the trigger twice at the top of the Piston 
Screw (under the Build Bed), and then squeeze the trigger once at the middle of the Piston Screw.

8. Spread the grease up and down the Piston Screw to evenly distribute it over the entire length of the 
screw.

9. Move the Build Bed up and down through its full range of travel a couple of times to finish lubricating 
the screw. Use the LCD menu items BUILD CHAMBER > RAISE PLATFORM and BUILD 
CHAMBER > LOWER PLATFORM. Don’t forget to hold down the Control Knob to raise or lower the 
platform.

10. Wipe off any grease that may collect at the bottom of the screw with a paper towel.

11. Replace the side and back cover panels.

12. Reset the Maintenance Counter in ZPrint.

6.3  Slow Axis Bearing Lubrication
Frequency: When prompted in ZPrint, or when you receive an Error 2303-0.

1. Locate the round plastic cover on the Deck to the left of the Build Bed and close to the Service Station.

2. Take a flat head screwdriver or a Pick Tool and pop the round cover off to expose the grease fitting. Be 
careful not to scratch the deck surface. An alternative method is to reach your fingers under the left 
side of the deck and pop the cover off from underneath.
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3. Pull the Fast Axis forward until you see the Slow Axis bearing in the center of the opening on the Fast 
Axis.

4. Assemble the grease gun that is part of your Accessories Kit according to the instructions.

5. Squeeze the handle until grease dispenses from the tip. Wipe clean with a clean paper towel. 

6. Place the tip of the grease gun over the grease fitting. Push down to snap the gun into place on the fit-
ting.

7. Squeeze the trigger 2 - 3 times or until you feel the tension change and then STOP. Do not over-
grease.

8. Unsnap the grease gun from the fitting. Replace the plastic cover.

9. Slide the fast axis forward and backward several times to spread the grease on the slow axis surfaces.

10. Reset the Maintenance Counter in ZPrint.

6.4  Replace the Carbon Filter
Frequency: When prompted in ZPrint

1. Unlatch and lower the Post-Processing Tray to the bottom of the Post-Processing Unit

2. Press the button to unlatch the Carbon Filter retainer.
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3.  Lower the retainer.

4. Remove the old Carbon Filter

5. Install the new Carbon Filter with the label at the top and facing out at you as shown.

6. Raise the retainer and latch it closed.

6.5  Clean The Alignment Sensor Window
Frequency: Clean the Alignment Sensor Window every time you change a print head, or remove a print 
head to clean the contacts and pogo pins.

1. On the Control Panel select BUILD CHAMBER, then LOWER PLATFORM. Continue holding in the 
Control Knob until the build bed is about 6” below the top. 

2. Pull the Fast Axis toward you and move it out over the build bed.

3. Wet a paper towel with distilled water and wipe off the alignment sensor window on the underside of 
the Carriage. The alignment window is located on the front left corner of the Carriage, under the bun-
dle of print head tubes. 

Note: Do not wipe the bottoms of the print heads.

4. Dry thoroughly with a clean paper towel. 
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6.6  Clean The Fast Axis Pulleys
Frequency: On a regular schedule, depending on your usage. Or, whenever the printer has problems or 
errors related to the Fast Axis motion.

1. Slide the fast axis out toward you.

2. Using the pick from the Accessories Kit, reach into the keyhole slot at the end of the fast axis and care-
fully remove any debris or powder from the teeth of the pulley. Slide the printhead carriage back and 
forth to rotate the pulley and expose all the teeth. 

3. Repeat this for the pulley at the other end.

4. Vacuum or sweep up any debris that fell on the deck or build bed.

6.7  Clean The Slow Axis Rails and Pulleys
Frequency: On a regular schedule, depending on your usage. Or, whenever the printer has problems or 
errors related to the Slow Axis motion.

1. Remove the two screws inside the front lip of the build chamber. This makes it easier to remove the 
deck.
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2. Unsnap the top deck from the chassis by pulling up at the front edge.

3. Lift up the front edge of the deck and slide the deck out toward you. Remove the deck from the printer. 
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4. On the LCD select VACUUM to turn the vacuum on. Thoroughly vacuum the area around the slow axis 
rails.  

5. Using a paper towel dampened with distilled water clean the slow axis rails on both sides. Carefully 
clean any debris from the ends of the left rail (see also next step). Dry both rails thoroughly with a 
clean dry paper towel. 

Number Component

1 Slow Axis Rails

2 Ends of Rail
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6. Using the pick from the Accessories Kit, reach below the slow axis rail and carefully remove any debris 
or powder from the teeth of the pulley. Slide the fast axis assembly forward and back to rotate the pul-
ley and expose all the teeth. Also clean any buildup or debris from the end of the rail.     

7. Repeat this for the pulley at the other end.

8. Vacuum or sweep up any debris that fell.

Number Component

1 Slow Axis Rail

2 Pulley

3 End of Rail
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9. Slide the deck back into position. Line up the cutout in the deck with the Service Station.

10. Press down on the front, middle and rear of the deck as shown to snap all 6 retainers back into posi-
tion. 

11. Replace the screws.
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6.8  Clean The Spreader Roller
Frequency: On a regular schedule, depending on your usage. Or, whenever the printer has problems 
related to the surface finish of horizontal surfaces.

1. On the LCD, select BUILD CHAMBER then LOWER PLATFORM. Lower the build bed by 4-5 inches.

2. Move the Fast Axis out over the build bed.

3. In ZPrint select Service then Toggle Roller On/Off to turn the Spreader Roller on.

4. Using a paper towel dampened with distilled water, clean the Spreader Roller thoroughly by reaching 
up from underneath. 

5. Dry the roller thoroughly with a clean dry paper towel.

6. In ZPrint select Service then Toggle Roller On/Off to turn the Spreader Roller off.

7. Make sure the roller is completely dry before attempting to spread any powder. 

6.9  Printer Storage Preparation 
The ZPrinter 650 should never be turned off so it can automatically service the print heads and exercise 
the moving components during idle times. 

If the printer will be unused for an extended period (several weeks or even months), some extra care is 
required to be sure your printer is ready to go when it is reactivated. Contact your dealer and request a 
copy of the Summer Storage Procedure. You can also download it from our Web site at
 zcentral.zcorp.com.

Number Component

1 Spreader Roller
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7 Troubleshooting the ZPrinter 650
If you should encounter any problems with your ZPrinter 650, the steps below will help you troubleshoot 
the problem and, in most cases, correct it yourself. If you need to call service, we’ve provided a list of the 
information to have ready for your Service Provider.

Start Here

Start with Section 7.1, ’Try This First’. In many cases this will solve the problem. 

Troubleshoot

If the problem persists, use these troubleshooting flowcharts and tables to isolate the problem. 

Power Up Problems

• Section 7.2, ’Problems Powering Up’

Motion Errors

• Section 7.3, ’Print Head Errors/ Weak Parts’

• Section 7.4, ’Alignment Errors’

• Section 7.5, ’Motion Errors - Fast Axis’

• Section 7.6, ’Motion Errors - Slow Axis’

Network Errors

• Section 7.7, ’Network Errors - Cannot Connect to Printer’

• Section 7.8, ’Network Errors - Packet Timeout’

Part Quality Problems

• Section 7.9, ’Part Quality Issues - General’

• Section 7.10, ’Part Quality Issues - Streaky or Striped Parts, Delamination’

• Section 7.11, ’Part Quality Issues - Bad Surface Finish’

Other problems

• Section 7.12, ’Miscellaneous Problems’

Additional information 

• Section 7.13, ’Error Codes and Messages - Background Details’

• Section 7.14, ’Additional Information’

Call for Service

If you do need to call service, use the checklist provided here to gather the information your Service Pro-
vider will need.

• Section 7.15, ’Calling for Service’ 
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7.1  Try This First
Before calling for service, follow these steps:

1. Clean the machine thoroughly!
This includes all parts of the deck, service station, axis rails, pulley teeth, and pogo pins. Remove any 
debris build up at the ends of travel, on the axis rail and even on the axis rail supports.

• Section 3.1, ’Vacuum Excess Powder’

• Section 3.2, ’Empty The Debris Separator’

• Section 3.3, ’Clean The Parking Caps’

• Section 3.4, ’Clean The Fast Axis Rails and Carriage’

• Section 3.5, ’Clean The Service Station’

• Section 6.5, ’Clean The Alignment Sensor Window’

• Section 6.6, ’Clean The Fast Axis Pulleys’

Finally, you should remove all 5 printheads and clean the pogo pins. If the printhead is old, dirty, or has 
reported an error through ZPrint, replace the printhead with a new one.

•  Section 5.2, ’Change Print Head(s)’ 

2. Perform any needed maintenance.
Check the Printer Status Dialog window in ZPrint for any maintenance that is due. 

• Section 5.1, ’The Printer Status Dialog’

3. Inspect the printer.
Perform a quick inspection of the machine. During the inspection you should be looking for any signs 
of leaks, loose screws or loose nuts. Loose screws or nuts should be tightened and leaks should be 
reported to your local Service Provider immediately.

4. Check for motion problems
Turn the machine off and move the carriage and fast axis to the middle of the build bed, then re-boot 
the machine. Watch for any obstructions or jumpy movements. If the movements are jumpy in any 
axis, clean the rail as described in step 1 above and lubricate that axis.

• Section 6.1, ’Fast Axis Bearing Lubrication’

• Section 6.3, ’Slow Axis Bearing Lubrication’
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7.2  Problems Powering Up
If your printer does not power up normally, use the flowchart below.
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7.3  Print Head Errors/ Weak Parts
There are a number of Error Codes the printer may report that all relate to the print heads, and that all 
share a common set of solutions. The same solutions also apply to parts that are weak and break too eas-
ily.

 Error Codes covered in this section: 

• Error 1000 Unknown head error

• Error 1001 Head Power Fail

• Error 1003 x Head Error

• Error 1004 x Head Error 

• Error 1005 x Head Error

• Error 1006 x Head Too Hot

• Error 1007 x Head Error

• Error 1009 x Head Error

• Error 1010 x Head Error

• Error 40800 x Head Error

• Error 40801 Headcard Power Fail

• Error 40802 x Use Only HP11

• Error 60700 Head X temperature calibration failed

• Error 60701 Head  X invalid serial number

• Error 60702 Head X temperature too high

• Error 10040 Pogo Comm Error

For more detailed information on what these errors mean, see Section 7.13, ’Error Codes and Messages - 
Background Details’.

7.3.1 Try This First

Most often, these errors (and weak parts) are caused by accumulation of powder, binder, and debris on the 
print heads. Dirty print heads, in turn, are very often caused by a service station that is dirty and not clean-
ing the heads properly. 

The first solution to try is to clean the service station thoroughly. See Section 3.5, ’Clean The Service Sta-
tion’.

If this fails to solve the problem, use the troubleshooting flowchart below.

How to do it  

To remove the printheads and clean the pogo pins, follow the steps in Section 5.2, ’Change Print Head(s)’. 
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7.4  Alignment Errors
If you have run an alignment pattern and the printer reports that the alignment has failed, follow the trou-
bleshooting flowchart below. 

How to do it  

If it passes alignment but the print quality is not OK, see Section 7.3, ’Print Head Errors/ Weak Parts’.
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7.5  Motion Errors - Fast Axis
There are a number of Error Codes the printer may report that all relate to the Fast Axis, and that all share 
a common set of solutions.

Error Codes covered in this section: 

• Error 2301:1 Motors Not Rezeroed

• Error 2303:1x Axis Pos Error

• Error 2305:1x Axis Settle 

• Error 2400:1x Axis Seek Error

• Error 3011 System Error

• Error 3013 Sequencer Timeout

• Error 43000 Sequencer Timeout

For more detailed information on what these errors mean, see Section 7.13, ’Error Codes and Messages - 
Background Details’.

How to do it  

To perform the cleaning and lubrication called for in the flowchart, see:

• Section 3.4, ’Clean The Fast Axis Rails and Carriage’ 

• Section 6.6, ’Clean The Fast Axis Pulleys’ 

• Section 6.1, ’Fast Axis Bearing Lubrication’ 
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7.6  Motion Errors - Slow Axis
There are a number of Error Codes the printer may report that all relate to the Slow Axis, and that all 
share a common set of solutions.

Error Codes covered in this section: 

• Error 2301:0 Motors Not Rezeroed

• Error 2303:0 x Axis Pos Error

• Error 2305:0 x Axis Settle Error

• Error 2400:0 x Axis Seek Error

• Error 3011 System Error

• Error 3013 Sequencer Timeout

• Error 43000 Sequencer Timeout

For more detailed information on what these errors mean, see Section 7.13, ’Error Codes and Messages - 
Background Details’.

How to do it  

To perform the cleaning and lubrication called for in the flowchart, see:

• Section 6.7, ’Clean The Slow Axis Rails and Pulleys’ 

• Section 6.3, ’Slow Axis Bearing Lubrication’  
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7.7  Network Errors - Cannot Connect to Printer
If you have trouble connecting to your printer over the network, follow the troubleshooting flowchart below.
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7.8  Network Errors - Packet Timeout
Explanation: The Packet Time Out error is a result of lost or impaired communication between the printer 
and the PC. 

A Packet Time Out error may also occur if the file is too large and the PC cannot transfer the file data fast 
enough. For example, some files may be layer-data heavy, meaning that the bulk of the data is in a small 
quantity of layers.

Solution: Check for these problems:

• The PC used to control the printer may

• Be too busy running other applications.

• Be running a virus or spyware scan.

• Be in a “sleep” or “suspend” mode due to power management settings.

• Not meet the minimum system requirements. See Section 1.3.1, ’Recommended System’. 

• The printer’s network connection may be lost

• Printer’s network cable may be unplugged, or damaged.

• Server is not responding.

• Network is too busy.

7.9  Part Quality Issues - General
There can be many causes to part quality issues. Refer to the sections that follow to find your problem, and 
the suggested solutions.

7.9.1 Part Colors Do Not Match PC Monitor Colors

Explanation: PC monitor settings are adjustable, and monitors vary in color accuracy. Monitor colors 
should not be used to gauge the color of printed parts. In addition, color cannot be properly judged until the 
part has been infiltrated and cured.

Solution: 

• Infiltrate and cure your parts before judging color.

• Be sure to check that your powder settings in ZPrint match the powder/printer combination that you are 
using. 

• Cleaning the Service Station after every build also plays a key role in color quality.

7.9.2 Parts Broken After Automatic Depowdering

Explanation: Either your parts are too small or too delicate to handle the vibration when the build chamber 
empties, or your parts are not printing correctly. 
zcentral.zcorp.com 82 All Rights Reserved

10/21/08

https://zcentral.zcorp.com


ZPrinter® 650 Hardware Manual Troubleshooting the ZPrinter 650
Solution: If your parts are thin-walled or just small, you may want to consider not using the automatic 
Empty Build Chamber feature. We also recommend that you generate a fixture with bumpers to support 
your part during the automatic empty build chamber cycle. In the screen shown below, the red area is the 
fixture and bumpers generated by ZPrint.

 

Also try these:

• Check the saturation levels for your powder type. If you load a .zbd file, it will load the saturation 
values saved for that part, so double check after you load your parts.

• Check for striped or streaky printing (see Section 7.10, ’Part Quality Issues - Streaky or Striped 
Parts, Delamination’).

• Clean the service station and the parking caps. Ensure the printer has cleaning solution. 

• Clean the Fast Axis rail of any debris and reboot the printer.
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7.10  Part Quality Issues - Streaky or Striped Parts, Delamination
Explanation: Streaky or striped parts are caused either by powder buildup on the print head, a failed print 
head, or an electrical issue within the printer. Delamination (layers splitting apart) may be due to a print 
head that is caked with powder, or a pause in network communications.

Solution - Both: 

• Clean the service station. See Section 3.5, ’Clean The Service Station’.

• Clean the parking caps. See Section 3.3, ’Clean The Parking Caps’.

• Ensure the printer has cleaning solution. 

• Realign the print heads to ensure proper alignment. 

• Clean the Fast Axis Rails of any debris and reboot the printer. See Section 3.4, ’Clean The Fast 
Axis Rails and Carriage’.

If the problem persists, 

• Clean the pogo pins and the print head contacts. 

• Realign the heads. If the pattern shows striping or streaking, one or more print heads may have 
failed. Change the print head and realign the heads. See Section 7.4, ’Alignment Errors’.

Additional Solution - Delamination

Check your PC settings. The printer may be pausing as it waits for additional data from the PC. While 
pausing, the printed part begins to dry and as a result the next layer does not stick to the last layer printed. 
Your PC should be dedicated to ZPrint. Your PC Power Management software should be completely shut 
off. 
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7.11  Part Quality Issues - Bad Surface Finish
The problems behind bad surface finish on parts will be different depending on whether the rough surface 
is in the vertical plane or the horizontal plane.

7.11.1 Bad Horizontal Surface Finish

Explanation: 

A bad surface finish on horizontal surfaces is usually the result of debris buildup on the Spreader Roller. 
The debris sticks to the Roller and prevents it from spreading a smooth, flat layer of powder.

Solution 

Clean the Spreader Roller. See Section 6.8, ’Clean The Spreader Roller’. 

7.11.2 Bad Vertical Surface Finish

Explanation: 

A bad surface finish on vertical surfaces is usually the result of either or both of these: 

• A problem with the print heads.

• A motion problem with either the Fast Axis or the Slow Axis.
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Solution - Print Heads

Troubleshoot using Section 7.3, ’Print Head Errors/ Weak Parts’. 

Solution - Motion Problems

• Clean the Fast Axis Rails. See Section 3.4, ’Clean The Fast Axis Rails and Carriage’.

• Clean the Fast Axis Pulleys. See Section 6.6, ’Clean The Fast Axis Pulleys’.

• Clean the Slow Axis Rails and Pulleys. See Section 6.7, ’Clean The Slow Axis Rails and Pulleys’.

7.12  Miscellaneous Problems

7.12.1 Vacuum Has Low/No Suction

Explanation: This is usually an indication that the Debris Separator needs to be emptied and cleaned.

Solution: 

• Remove the Debris Separator and empty the contents into a waste receptacle. 

• Check that its gasket is not damaged. Also check that all four magnets are in place on the back of the 
Separator. These magnets hold the Separator against the panel.

• When you replace the Debris Separator, ensure that it is flush against the panel. 

• Check the vacuum hose is not plugged with debris.

• Check that the vacuum hose is not cut or torn. 

If, after checking these items the problem persists, contact your Service Provider.
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7.12.2 Binder Cartridge is Full But ZPrint Indicates Empty

Explanation: This is usually caused by a damaged binder cartridge, or a failure in the binder cartridge 
pocket.

Solution: 

• Remove and reseat the binder cartridge. Check the following:

• Be sure it’s the correct cartridge for that pocket.

• Check the label to be sure it’s oriented correctly.

• Snap it fully into place in the pocket.

If that doesn’t solve the problem, try a new binder cartridge.

If a new binder cartridge doesn’t solve the problem, contact your Service Provider.
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7.13  Error Codes and Messages - Background Details
Below is a more detailed explanation of some of the error codes and messages the printer may report.

ERROR CODE

Error 40800

Error 1004

Error 1010

Error 1009

Error 1003

Error 1008

Explanation: 1000ml is the expected life of a print head that uses 
clear binder; 500ml is expected life for a color or black print head. 
In the rare instances where they do not, the reasons are varied. 
Some print heads may fail if the printer does not run a build on a 
regular basis. They may also prematurely fail if the printer is 
turned off for long periods. Color print heads will also be affected 
by the printer sitting too long without running.

Solution: We recommend leaving your printer turned on when not 
in use. Doing this will allow the printer to automatically maintain 
the print heads with a routine it runs between builds. Also, when 
changing a print head, be sure to clean the pogo pins at the same 
time. Failure to clean the pogo pins may result in poor contact to 
the print head, causing the system to report an error and prevent-
ing operation of the printer.

Error 1006 Explanation: This error is most likely caused by a print head 
reaching the end of its life. As a print head ages, it overheats and 
eventually reports this error. It could also be a failed connection 
between the printer and the print head. 

Solution: This error is most often avoided by following best prac-
tices for keeping the printer clear of excess powder and to clean 
the pogo contacts every time a print head is changed. Even if only 
one print head is replaced, it is good practice to clean the contacts 
for all 5 print heads every time a print head is replaced.

The ZPrinter 650 will prompt you when a print head has reached 
its maximum life and requires changing. Change the print head 
according to the instructions in this manual. When a print head is 
changed, the ZPrinter 650 will run an automatic purge cycle for the 
binder cartridge only. Once the purge cycle is complete, the printer 
runs the auto-alignment pattern to align the clear and color print 
heads.
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7.14Additional Information

7.14.1 Materials

Visit the Materials section of our Web site to get the latest information on: 

• Materials that are compatible with your printer.

• Best Practices to help you create the very best parts.

zcentral.zcorp.com

7.14.2 Service

Visit the Support section of our Web site for tips on maintaining your printer, troubleshooting problems, or 
to contact our Service staff:

zcentral.zcorp.com

7.15  Calling for Service
If you are still experiencing problems after troubleshooting contact your local Service Provider with the 
below information.

• Serial Number

• Company Name and Contact Info

Error 2303 (0)

Error 2303 (1)

Explanation: If the error shows 2303 (0) it means that there is 
excessive friction on the slow axis rails, or something is obstruct-
ing the travel path of the axis. If the error is 2303 (1), it means that 
there is excessive friction on the fast axis rails, or something is 
obstructing the travel path of the axis. 

Solution: First, ensure there is nothing blocking the travel path of 
either axis. If there is no obstruction, then it usually means that the 
fast or slow axis needs to be greased. Follow the instructions in 
the Printer Maintenance chapter for greasing the slow or fast axis. 
Also, inspect the pulleys for debris buildup. If the pulleys need 
cleaning, refer to the instructions in the Printer Maintenance chap-
ter. 

Error 1905       Explanation: This error is caused by a layer that is too large for 
the printer’s buffer. The printer is unable to process the layer and 
reports the error. This is most common with GIS, architecture, and 
scanned files, which are usually very large. 

Solution: Try rotating the part on the X-Z-axis to increase the 
layer count and reduce the size of each layer. The risk in doing this 
is ZPrint is unable to check for layer size before it begins the build. 
We recommend reducing the detail on the file and trying the print 
again.

ERROR CODE
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• Log File (obtainable through the ZPrint Software Service Menu)

• .INI File (Obtainable through the ZPrint Software Service Menu)

• SPREAD.CSV File(Z450 and Z650) (Obtainable through the ZPrint Software Service Menu, 
Receive File option)

• Head Report Information (Obtainable through the ZPrint Software Service Menu)

• Binder/Powder Types

• Binder/Powder Expiration Dates

• EXACT Error Code/ Description of Problem
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Lubrication, Piston Screw, 60
Lubrication, Slow Axis Bearing, 62

M
Main Window, ZPrint, 22
Maintenance Dialog, ZPrint, 59
Maintenance, Printer, 59
Make Bumper, Fixtures, 27

Make Fixture, General Preferences, 27
Materials, 2, , 89
Mirror, Toolbar Shortcut, 26
Monochrome, Print option, 32

N
Network Connectivity, 1
New Features, 1
New Powder Type, 24
Noise Levels, 2

O
Open A Part, 21
Open or hollow area of part, 20
Operating Environment, 1
Options, Printer Status Dialog, 31
Orientation, Part, 19
Overhangs, Parts with, 20

P
Parking Caps, Clean, 38
Parking Caps, Definition, 5
Part accuracy, 19
Part Accuracy, Overview, 19
Part Orientation, 19
Part placement, 19
Part strength, 19
Part Strength, Overview, 19
Part, Dry, 33
Part, Open in ZPrint, 21
Part, Transform, 24
Parts With Overhangs, 20
Parts, Cylindrical, 20
Piston Screw, Lubrication, 60
Platform, Definition, 5
Pogo Pins, Definition, 5
Powder Removal, Automatic, 33
Powder Removal, Fine, 34
Powder Screen, Definition, 5
Powder Settings, Defaults, 24
Powder Type, Create New, 24
Powder, Add To Feeder, 56
Powder, Definition, 5
Power Requirements, 2
Power Up Problems, 73
Preheat Build, 32
Prep Build Chamber, 58
Prepare, Build Area, 30
Print Head Contacts, Definition, 5
Print Head Errors, 74
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Print Head, Definition, 5
Print Heads, 2
Print Job Options, 31
Print the Build, 31
Printer Maintenance, 59
Printer Settings, Default, 22
Printer Status Dialog, Add Powder Message, 56
Printer Status Dialog, Change Print Head Message,
52
Printer Status Dialog, Close Cover Message, 58
Printer Status Dialog, Messages, 50
Printer Status Dialog, Raise Build, 58
Printer Status, Dialog, 31
Printer Storage, 70
Printing Dialog, 32
Printing Speed, Overview, 19
Printing the Build, 31
Purge, Definition, 5

R
Raise Build, Printer Status Dialog, 58
Rear View Diagram, 11
Requirements, Computer, 2
Requirements, Power, 2
Requirements, Workstation, 2
Resolution - Printer, 2
Rotate, Toolbar Shortcut, 25
Routine Cleaning, 36

S
Scale, Toolbar Shortcut, 25
Select Printer, 30
Service, 89
Service Station Diagram, 12
Service Station, Clean, 42
Service Station, Definition, 5
Settings, Check Build, 29
Settings, Powder, 24
Setup And Print, 19
Slice View, 29
Slice view, 29
Slow Axis Bearing, Lubrication, 62
Specifications, 1
Speed, Build, 2
Speed, Printing, 19
Storage Preparation, Printer, 70
Strength, 19
Strength, Part, 19

T
Terms, 4
Toolbar Shortcuts, Transform, 25
Transform Menu, Undo Command, 26
Transform, Part, 24
Translate, Toolbar Shortcut, 25
Troubleshooting, 71

U
Undo, Description, 26

V
Vacuum Has Low/No Suction, 86
Vacuum, Powder, 36
Volume, Build, 2

W
Waste System, 2
Waste Tray, Definition, 4
Weak Parts, 74
Weight - Printer, 1

Z
ZPrint, Main Window, 22
ZPrint, Maintenance Dialog, 59
ZPrint, Transform Part, 24
ZPrint/ZEdit Installation, 21
ZPrinter 650 Overview, 1
ZPrinter 650, Components, 6
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